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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking on an enterprise solution consisting of Avaya IP Office 10.0 to support
NexVortex SIP Trunking Service.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the public switched telephone network (PSTN) with various Avaya
endpoints.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunking service between NexVortex and an Avaya SIP-enabled enterprise solution.

In the configuration used during the testing, the Avaya SIP-enabled enterprise solution consists
of Avaya IP Office 500 V2 Release 10.0 (hereafter referred to as IP Office) and various Avaya
endpoints, listed in Section 4.

The NexVortex SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the IP Office solution are able to place
and receive PSTN calls via a broadband wide area network (WAN) connection using the SIP
protocol. This converged network solution is an alternative to traditional PSTN trunks such as
analog and/or ISDN-PRI trunks. This approach generally results in lower cost for the enterprise.

The terms “service provider” or “NexVortex” will be used interchangeably throughout these
Application Notes.

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to NexVortex’s network via
the public Internet, as depicted in Figure 1, and exercise the features and functionalities listed in
Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.

For the testing associated with this Application Note, the interface between the Avaya system
and the NexVortex network did not include the use of any specific encryption features.
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2.1. Interoperability Compliance Testing

To verify SIP trunk interoperability the following features and functionalities were exercised
during the interoperability compliance test:

Public DNS “SRV” record queries to establish the SIP trunk connection.

SIP Trunk Registration (Dynamic Authentication).

Response to SIP OPTIONS queries.

Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, digital, and
analog telephones at the enterprise. All incoming calls from the PSTN were routed to the
enterprise across the SIP Trunk from the service provider networks.

Outgoing PSTN calls from Avaya endpoints including SIP, H.323, digital and analog
telephones at the enterprise. All outgoing calls to the PSTN were routed from the
enterprise across the SIP trunk to the service provider network.

Incoming and outgoing PSTN calls to/from Avaya Communicator for Windows
Softphone.

Incoming and outgoing PSTN calls to/from Avaya Communicator for Web softphone.
Local calls.

Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with coverage to
voicemail off).

Proper response to busy endpoints.

Proper response/error treatment when dialing invalid numbers.

Proper codec negotiation and two way speech-path. Testing was performed with codecs:
G.711MU and G.729(a), NexVortex’s preferred codec order.

Proper response to no matching codecs.

Proper early media transmissions.

Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail
messages, etc.).

Calling number blocking (Privacy).

Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

Mobility twinning of incoming calls to mobile phones.

T.38 and G711 pass-through fax.

Items not supported or not tested included the following:

REFER is not currently supported by NexVortex.
Inbound and Outbound toll-free calls were not tested.

0, 0+10 digits and 911 Emergency calls were not tested.
Outbound international calls were not tested.
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2.2. Test Results
Interoperability testing of NexVortex SIP Trunking Service was completed with successful
results for all test cases with the exception of the observations/limitations described below.
e (.711 Pass-Through fax: Fax calls using G.711 Pass-Through did not work properly,
fax using T.38 was successfully tested. The use of T.38 fax is recommended for this
solution.

2.3. Support
For support on NexVortex systems visit the corporate Web page at: https://www.nexvortex.com/

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the test configuration used for the DevConnect compliance testing. The test
configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution
connected to the NexVortex SIP Trunking Service through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
e Avaya IP Office 500 V2.
e Avaya Voicemail Pro for IP Office.

Avaya IP Office Application Server.

Avaya 96x1 Series H.323 IP Deskphones.

Avaya 1100 Series SIP IP Deskphones.

Avaya Communicator for Windows softphone.

Avaya Communicator for Web softphone.

Avaya 1408 Digital Deskphones.

The enterprise site contains the Avaya IP Office 500 V2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of Avaya IP Office is connected to the enterprise LAN (private network)
while the LAN2 port is connected to the public network. Endpoints include Avaya 96x1 Series
IP Deskphones (with H.323 firmware), Avaya 1100 IP Deskphones (with SIP firmware), digital,
and analog Deskphones, PC running Avaya Communicator for Windows and Avaya
Communicator for Web softphones. The site also has a Windows PC running Avaya IP Office
Manager to configure and administer the IP Office system, and Avaya Voicemail Pro providing
voice messaging service to the IP Office users. Mobile Twinning is configured for some of the IP
Office users so that calls to these user’s extensions will also ring and can be answered at the
configured mobile phones. The Avaya IP Office Application Server is required for Avaya
Communicator for Web softphones.

The transport protocol between IP Office and NexVortex, across the public Internet, is SIP over
UDP. The transport protocol between Avaya endpoints and IP Office, inside the enterprise
private IP network (LAN), is SIP over TLS.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to NexVortex. The short code 9 was stripped off by IP Office but the
remaining N digits were sent unaltered to the network. Refer to Section 5.5 for configuration.

The NexVortex SIP Trunk Service sends 11 (1 + 10) digits number in the Request-URI and the
To header in inbound SIP INVITE messages.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the IP Office system, such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond
the scope of these Application Notes. However, it should be noted that all SIP and RTP traffic
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between the service provider and the IP Office system must be allowed to pass through these

devices.

For confidentiality and privacy purposes, public IP addresses, domain names, and routable DID

numbers used during the compliance testing have been masked.

Service Provider

-
|
[
|
\_ |
| | DNS “SRV” Record:
| test123.com
SIP (UDP/RTP} |
I
|
|
| Internet
|
( Analog 1' Simulated Enterpri
na imulated Enterprise
Deskphonas : Domain: avnya.lah.m?n
Avaya IP Office 500 V2. | DiDs: 12015781234 to 5678
Rel 10.0 |
Avaya 1408 I
Digital Deskphones |
|
10.10.80.52 |
10.64 TG0 (Lanz) | SIP (UDPIRTP) Fax
(LANT)
Avaya |PO Office
Application Sever
- Avaya One-X Portal
- Avaya WebRTC gateway
- IP Office Manager
- Voice Mail P
- ,13;5:3 Cculmr:lfmlcawrfnr nr;ﬁm‘:::;rs Avaya 1100 Series IP
Windaws (SIP) (H.323) Desklphones
- Avaya Communicator for (SIP)
Web
.
Figure 1: Avaya Interoperability Test Lab Configuration
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment/Software

Release/Version

Avaya

Avaya IP Office 500v2

10.0.0.3.0 Build 5

Avaya IP Office DIG DCPx16 V2

10.0.0.3.0 Build 5

Avaya IP Office Manager

10.0.0.3.0 Build 5

Avaya Voicemail Pro

10.0.0.3.0 Build 5

Avaya IP Office Application Server
- Avaya WebRTC Gateway
- Avaya one-X Portal for IP Office

10.0.0.2.0 Built 10
10.0.0.3.0 Built 7
10.0.0.2.0 Built 13

Avaya 96x1 Series IP Deskphones (H.323)

Version 6.6401

Avaya 1140E IP Deskphones (SIP)

SIP1140e Ver. 04.04.23.00

Avaya Communicator for Windows 2.1.3.0-237

Avaya Communicator for Web 1.0.16.1718

Avaya Digital Deskphones 1408 R46

Lucent Analog Phone --
NexVortex

Kamailio | 4.4

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone
IP Office 500 V2 and also when deployed with all configurations of IP Office Server Edition.
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5. Configure Avaya IP Office

This section describes the IP Office configuration required to interwork with NexVortex SIP
Trunking Service. IP Office is configured through Avaya IP Office Manager (IP Office
Manager) which is a PC application. On the PC, select Start = Programs = IP Office =
Manager to launch IP Office Manager. Navigate to File > Open Configuration, select the
proper IP Office from the pop-up window, and log in with the appropriate credentials. A
management window will appear as shown in the next sections. The appearance of IP Office
Manager can be customized using the View menu (not shown). In the screenshots presented in
this section, the View menu was configured to show the Navigation pane on the left side and the
Details pane on the right side. These panes will be referenced throughout these Application
Notes.

These Application Notes assume the basic installation and configuration of IP Office have
already been completed and are not discussed here. For further information on IP Office, please
consult Error! Reference source not found. in Section 9.

5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License, then
from the license tab, locate SIP Trunk Channels. Confirm that there is a valid license with
sufficient “Instances” (trunk channels) in the Details pane.

IP Offices |
- & BOOTP (5) License || Remote Server
P500V2 Main License Mode License Normal

System (1) Licensed Version 10.0

= IP500V2 Main
+T‘, Line (25) PLDS Host ID
+-+2r Control Unit (4) i i
+¢ Extension (48) PLDS File Status  Valid
+-§  User (50)
+’“ Group (1) Feature Key Instances Status Expiration Date|
+-@% Shert Code (69)
- @ Service (0) Essential Edition y _vASUrz0SrLW 255 Obsolete Mever
+m§,,< RAS (1) Receptionist MN/A 4 Valid Mever
-9 Incoming Call Route (3) Additional Voicemail Pro Ports N/A 152 Valid Never
@ “‘TAN Port (0) WMPro Recordings Administrators  N/A 1 Valid Never
22 Directory (0] Essential Edition Additional Voice.. N/A 4 Valid Never
Time Profile (0}
@ Firewall Profile (1) WMPro TTS (Generic) N/& 40 Valid Mever
il IP Route (7) Teleworker MN/A 384 Valid Mever
Account Code (0) Mobile Worker N/ A 384 Valid Mever
Office Worker N/A 384 Valid MNever
+gm E?;n;il (ﬂis @ Avaya Softphone Licence N/A 100 Valid MNever
+(‘ ARS mg WMPro TTS (Scansoft) M8 40 Valid Mever
..... 5% Location (0) WMPro TTS Professional /A 40 Valid Never
-8 Authorization Code (0) IPSec Tunnelling MN/A 1 Valid MNever
Power User M/ 384 Valid Mever
IP500 Voice Networking Channels /A 32 Valid Mever
SIP Trunk Channels MN/A 128 Valid MNever
IP500 Universal PRI (Additional cha... MN/4 100 Valid Mever
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To view the physical hardware comprising IP Office, expand the components under the Control
Unit in the Navigation pane. In the sample configuration, the Avaya IP Office 500 V2 is
equipped with analog and digital extension expansion modules, as well as a VCM64 (Voice
Compression Module) for supporting VolP codecs. An IP Office hardware configuration with a

VVCM component is necessary to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The

following screen shows the details of the IP 500 V2.

x

IP Offices = IP 500 V2
- R BOOTP (5) Unit
+-¢# Operator (3)
=45 IP500V2 Main Device Numnber 1
fr---"-:- Systern (1)
+-F7 Line (25) Unit Type IP 500 V2
T C_””"] Version 10.0.0.3.0 build 5
: ;EEEE‘E;RID v Senial Murmber
i besiy b DIG DCP1G V2 .
: 10.64.70.50
+& Extension (48) Unit IP &Address
+= User (50) Interconnect Number 0
+ﬂ Group (1)
+“ Short Cede (69) Module Number Control Unit
B Service (0)
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5.2. System
Configure the necessary

system settings. In an IP Office the LANZ tab settings correspond to the

IP Office WAN port (public network side) and the LAN1 tab settings correspond to the LAN
port (private network side).

5.2.1. System — LAN2 Tab
In the sample configuration, the IP Office WAN port was used to connect to NexVortex. The
LAN?2 settings correspond to the WAN port on the IP Office 500 V2. To access the LAN2
settings, first navigate to System - <Name>, where <Name> is the system name assigned to IP
Office. In this compliance test, the system name is IP500V2 Main. Next, navigate to the LAN2
- LAN Settings tab in the Details pane, configure the following parameters:

e Setthe IP Address field to the public IP address assigned to the IP Office WAN port.

e Setthe IP Mask field to the mask used with the public IP address. All other

parameters should be set to default or according to customer requirements.
e Click OK to commit (not shown).

IP Offices

b=y IP500V2 Main*

- % BOOTP (5)

+, Operator (3)

== IPS00V2 Main
|-+ System (1]
Ly IPS00V2 Main
~T4 Line (25)

= Control Unit (4)
-4 Extension (48)
= User (50)

-ipg Group (1)

-@% Short Code (69)
@ Service (0]
+-§ Incoming Call Route (3)
~48) WAN Port (1)

a4 Directory (0)

-7 Time Profile (D)

-8 Firewall Profile (1)
+-Jill IP Route (7)

-l Account Code (0)
- License (90)

i Tunnel (0)

+-§3 User Rights (8)

5-¢ ARS (2)

- Location (0)

“-398 Authorization Code (0)

| System | LANL I LANZ |DNS |Voicemai| | Telephonyl Directory Services | Systern Events

LAN Settings |VoIP | Network Topology|

IP Address 10 10 &0 52

IP Mask 255 255 255 0

Primary Trans. IP Address 0 0 0 0

Firewall Profile | <None> -

RIP Mode [ None -
[] Enable NAT

-

Mumber Of DHCP IP Addresses 200
DHCP Mode

) Server () Client ) Dialln @ Disabled Advanced
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On the VolIP tab in the Details pane, configure the following parameters:

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to

NexVortex.

e Verify the RTP Port Number Range settings for a specific range for the RTP traffic.
The Minimum and Maximum values were kept as default.

IP Offices

= IP500V2 Main

@=-& BOOTP (5)

[#-¢# Operator (3)
!

e Line (25)
H-<2r Control Unit (4)
v Extension (48)
H-§  User (50)
J:ﬂ Group (1)
H- 8% Short Code (69)
B Service (0)
(ol RAS (1)
(-4 Incoming Call Route (3)
-8 WAN Port (0)
Directory (0)
£ Time Profile (0)
(-8 Firewall Profile (1)
-l IP Route (7)
-l Account Code (0)
% License (90)
il Tunnel (0]
[ User Rights (8)
(- ARS (2)
&5 Location (0)
'.m Authorization Code (0]

| System | LANL | LAN2  [DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR [VEM | VolP | VelP Security

| LAN Settingsl VolP | Network Topology|

[] H.223 Gatekeeper Enable

Auto-create Extension Auto-create User

Disabled

SIP Trunks Enable

[T] SIP Registrar Enable
Auto-create Extension/User

sil.miami.avaya.com

sil. miami.avaya.com

upP 5060

TCP 5060

TLS 5061

10

RTP
Port Mumber Range
Minimum 49152 = Maximum 53246 =
Port Mumber Range (MAT)
Minimum 49152 = Maximum 53246 z

H.323 Remote Extension Enable

1720

SIP Remote Extension Enable

5060

5060

5061
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Scroll down the page:

e Inthe Keepalives section, set the Scope to RTP-RTCP. Set the Periodic timeout to 30
and the Initial keepalives parameter to Enabled. These settings will cause IP Office to
send a RTP and RTCP keepalive packet starting at the time of initial connection and
every 30 seconds thereafter if no other RTP/RTCP traffic is present. This facilitates the
flow of media in cases where each end of the connection is waiting to see media from the
other, as well as helping to keep firewall ports open for the duration of the call.

e Inthe DiffServ Settings section, IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient,
appropriate values will be provided by the customer.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices = IP500V2 Main

- BOOTP (5) | System | LANL [ LAN2 |DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | vem

+-1# Operator (3)

= IP500V2 Main | LAN Settings [ VolP | Network Topology |
2 System (1) Minimum 49152 = Maximum 53246 =
S0 IPS00V2 Main
-3 Line (25)
+ > Control Unit (4) Port Mumber Range (NAT)
- Extension (48) Minirmum 49152 = Maxirnurm 53246 =
+-§  User (50)
45 Group (1) 7] Enable RTCP Monitoring on Port 5005
+“ Short Code (65)
""" @ Service (0) RTCP collector IP address for phones 0 0 0
+© Inceming Call Route (3) Keepalives
----- 8 WAN Port (1) Scope [RTP-RTCP ~| Periodic timeout 30
a4 Directory (0)
..... £ Time Profile (0) Initial keepalives |Enah|ed v|

<18} Firewall Profile (1)
+-Jfll IP Route (7)
----- B Account Code (0)
----- B License (90)

- DiffServ Settings
----- W& Tunnel (0)
f---ﬁ‘, User Rights (8) B3 + DSCP(Hex) B8 * Video DSCP (Hex) FC +| DSCP Mask (Hex) (88 + SIG DSCP (Hex)
_( ARS ()
" 50: Main 46 ~| Dsce 46 = Video DSCP 63 = DSCP Mask 34 ~| SIG DSCP
- 51: Outbound Fax
----- B8 Location () R
----- ﬁ Authorization Code (0) DHCP Settings
Primary Site Specific Option Mumber (550M) 176 =
Secondary Site Specific Option Number (S50M) 242 =
VLAN Mot Present v

1100 Voice VLAM Site Specific Option Mumber (SSON) 232 =

1100 Voice VLAN IDs

Note: In the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site IP network (private network). The LAN1 interface configuration is not directly
relevant to the interface with the NexVortex SIP Trunking Service, and therefore is not described
in these Application Notes.
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5.2.2. System - Telephony Tab
To access the System Telephony settings, navigate to the Telephony - Telephony tab in
the Details pane, configure the following parameters:

e Choose the Companding Law typical for the enterprise location, U-Law was used
for the compliance test, A-Law could have been selected instead.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding
and call transfer to the PSTN. If for security reasons incoming calls should not be
allowed to transfer back to the PSTN then leave this setting checked.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices

IP500V2 Main

BOOTP (5)
Operator (3)

550 System (1)

IP500V2 Main

- IPS00V2 Main

o

-

@

e [

T4 Line (25)

= Control Unit (4)

-4 Extension (48)

-@  User (50)

-5 Group (1)

8% Short Code (69)

4B Service ()

-, RAS (1)

[ @ Incoming Call Route (3)

$8 WAN Port (0)

- Directory (0]
(-\ Time Profile (0}
- Firewall Profile (1)
-l 1P Route (7)

-l Account Code (0)
B License (90)

i Tunnel (07

-f4 User Rights (8)
- ARS (2)

"¢ 50: Main

----- ¥ 51: Qutbound Fax

- Location (0)
ﬁ Authorization Code (0)

| System [LANL | LAN2 | DNS | Voicemail | Telephony § Directory Services | System Events [ sMTP | SMDR [vem [ volp | volP Security

Telephony | Park&Pagel Tones&Mu;icl Ring Tone;l SM

Analogue Extensions

[ caiog [Tur |
Companding Law
Switch Line
Default Outside Call Sequence INormaI V]
Default Inside Call Sequence lRingTypel '] @ U-law @ U-Law Line
Default Ring Back Sequence lRing Typel V]
o) A-Law _) A-Law Line

Restrict Analegue Extension Ringer Voltage

Dial Delay Time (sec) 4
Dial Delay Count 0

Default Mo Answer Time (sec) 15

Al | ([<D] (ST (D] ([T {[<Te

Hold Timeout (zec) 0
Park Timeout (sec) 300
Ring Delay (sec) 5

Call Priority Promotion Time (sec) |Disabled

Default Currency usD

o

[ DSS Status
Auto Held
Dial By Mame

Show Account Code

||:| Inhibit Off-Switch Forward/Transfer

[ Restrict Netwerk Interconnect
Include location specific information
|| Drop External Only Impromptu Conference

|| Visually Differentiate External Call

HG;
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5.2.3. System - VoIP Tab

To view or change the System Codecs settings, navigate to the VolP tab in the Details pane as
shown in the following screen, configure the following parameters:
e The RFC2833 Default Payload field allows for the manual configuration of the payload
type used on SIP calls that are initiated by the IP Office. The default value 101 was used.
e For codec selection, select the codecs and codec order of preference on the right, under
the Selected column. The Default Codec Selection area enables the codec preference
order to be configured on a system-wide basis. The buttons between the two lists can be
used to move codecs between the Unused and Selected lists, and to change the order of
the codecs in the Selected codecs list. By default, all IP lines and phones (SIP and H.323)
will use the system default codec selection shown here, unless configured otherwise for a
specific line or extension. The example below shows the codecs used for IP phones (SIP
and H.323), the system’s default codecs and order was used.
e Click OK to commit (not shown).

IP Offices
- R BOOTP (5)

= IP500V2 Main

| system | LaNL | LaM2 [ DNS [ Voicemail | Telephony | Directory Services | System Events | sMTP | sMDR [vem fVolP {

+-4#% Operator (3)
=I5 IPS00V2 Main Ignore DTMF Mismatch For Phones
=7 Systern (1)

= IP500V2 Main Allow Direct Media Within NAT Location
-1 Line (25)
-+ Control Unit (4) |RFC2833 Default Payload 101 - |
-4 Extension (48)
+§ User (50) Available Codecs Default Codec Selection
+’“ Group (1) Unused Selected
#-8 Short Code (69) W] G711 ULAW 64K 6,722 64K 23> G711 ULAW 64K
+E ;i’;"(‘le] 0 ¥] G.711 ALAW 64K G711 ALAW 64K
+® Incoming Call Route (3) V| G722 64K (G.729(a) 8K C5-ACELP
: | G.729(a) 8K CS-ACELP G.7231 6K3 MP-MLQ
@ WAN Port (0 7] 6.723.1 6K3 MP-MLQ
2= Directory (0) “es
Tirme Profile (0)
Firewall Profile (1)
Bl 1P Route (7)
- Account Code (0) >3

...... % License (90)

Note: The codec selections defined under this section (System — VoIP Tab) are the codecs
selected for the IP phones/extensions. The codec selections defined under Section 5.3.7 (SIP
Line — VVoIP tab) are the codecs selected for the SIP Line (Trunk).
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5.2.4. System - DNS Tab

To access the System DNS settings, navigate to the DNS tab in the Details pane, configure

the following parameters:

e Under DNS Server IP Address and Backup DNS Server IP Address enter the
primary and backup public DNS servers IP addresses. These IP addresses should be
provided by NexVortex.

e Click OK to commit (not shown).

@ Incoming Call Route (3)

IP Offices = IP500V2 Main
a BOOTP (3) System | LANL | LAMZ | DNS I‘u‘oicemail |Telephony Directory Services | System Events
{# Operator (3)
=55 IP300V2 Main DNS Server IP Address 8 ] 8 ]
{5 System (1)
o] s IPS00V2 Main Backup DNS Server IP Address | 75 75 75 75
E-T4 Line (25)
B2 Control Unit (4) DNS Domain
b4 Extension (48)
B-§  User (50) WINS Server IP Address 0 0 0 0
-5 Group (1) Backup WINS Server IP o . o o
g Short Code (69) Address
e Service (0]
n% RAS (1) WINS Scope
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5.2.5. IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to route calls to NexVortex’s network.

Navigate to IP Route, right-click on IP Route and select New. The values used during the
compliance test are shown below:
e Set the IP Address and IP Mask to 0.0.0.0 to make this the default route.
e Set Gateway IP Address to the IP address of the gateway/router used to route calls to the
public network, e.g., 10.10.80.1.
e Set Destination to LAN2 from the pull-down menu.
e Click OK to commit (not shown).

‘x—

IP Offices = 0.0.0.0

#-R BOOTP (5) IP Route

+-47 Operator (3]
-9 | IP500V2 Main IP Address 0 0 0 0

%% System (1)
-7 Line (25) IP Mask 0 0 0 0

+|
#-< Control Unit (4] Gateway IP Address 0 . 10 . 80 1
4
;

-4 Bxtension (48)
i@ User (50) Destination lLAN?.
+-5§ Group (1)
+-8% Short Code (69) Metric 0
,,E ,Ej;'ae) o [C] Proxy ARP
+e Incoming Call Route (3)
----- B WAN Port (0)

----- =1 Directory (0)

----- 37 Time Profile (0)

+1-{8) Firewall Profile (1)

=Kl P Route (7)
=1 110000
-l 10.64.101.0
-l 10.64.70.0

Sl 17231210

------ Bl 1921681280
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5.3. SIP Line

A SIP Line is needed to establish the SIP connection between IP Office and the NexVortex SIP
Trunking Service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP
Office Manager to create a SIP Line. Follow the steps in Sections 5.3.1 and 5.3.2 to create the
SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP trunk registration credentials.

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Section 5.3.3 t0 5.3.9.

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the
Navigation pane and select New => SIP Line. Then, follow the steps outlined in Sections 5.3.3
t0 5.3.9.

5.3.1. Importing a SIP Line Template

Note — DevConnect generated SIP Line templates are always exported in an XML format. These
XML templates do not include sensitive customer specific information and are therefore suitable
for distribution. The XML format templates can be used to create SIP trunks on both IP Office
Standard Edition (500v2) and IP Office Server Edition systems. Alternatively, binary templates
may be generated. However, binary templates include all the configuration parameters of the SIP
Line, including sensitive customer specific information. Therefore, binary templates should only
be used for cloning trunks within a specific customer’s environment.

1. Copy a previously created template file to a location (e.g., C:\Temp) on the same computer
where IP Office Manager is installed. By default, the template file name will have the format
<user supplied text>.xml, where the <user supplied text> portion is entered during template
file creation.

Note — If necessary, the <user supplied text> portion of the template file name may be
modified, however the <user supplied text>.xml format of the file name must be maintained.
For example, an original template file Test.xml could be changed to Testl.xml. The template
file name is selected in Section 5.3.2, step 1, to create a new SIP Line.
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2. Import the template into IP Office Manager. From IP Office Manager, select Tools =

Import Templates in Manager.

=& BOOTP (3)
[#-¢# Operator (3)
EI'"’"T.&' O0EQOT0B530F
=429 System (1)
Ly (OEDO706

o1

File Edit View | Tools | Help
5 a E Extension Renumber...
O0ED0T06530F Line Renumber...
Connect To...
IP Ofi
Export

SCM Service User Management
Busy on Held Validation

MSM Configuration
Print Button Labels

P URI|VolP

| Import Templates in Manager

License Migration

ne

Location

A folder browser will open. Select the directory used in step 1 to store the template(s) (e.g.,

C:\Temp).

=

Browse Fo

r Folder

(S |

Select a

folder to import templates from -

. ProgramData
. SUPPORT
 swtools

) swwork

. Temnp

/ tmp
. Trilogy

) Users
1

| ok

] [ Cancel

)

In the reference configuration, template files NexVortexIPO10.xml was imported. The template
files are automatically copied into the IP Office default template location, C:\Program
Files\Avaya\lP Office\Manager\Templates.
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3. After the import is complete, a final import status pop-up window will open stating success
or failure. Click OK.

-

Template Provisioning

S

) ChTemp

5.3.2. Creating a SIP Trunk from an XML Template

o Successfully imported templates to IP Office Manager from

L

1. To create the SIP Trunk from a template, right-click on Line in the Navigation pane, and
select New from Template = Open from file.

IP Offices

W
X
P

=R BOOTP (5)
4% Operator (3)

SIP Line |Transport |SIP URI|VelP  [T38 Fax| SIP Credentials

EI"“.H Q0EDOTOE530F line Murmher 20 =
E'!-,;_, S‘_‘r"S- ::J NE‘IN
EI" & Cut Ctrl+X
.33 Copy Ctrl+C
e Paste Ctrl+V ISIP
N Ctrl+Del | Cloud
. 75 Delete trl+De ou
Lwg | o/ Validate
- Co Connect To... Ctrl+T
- Ext
w§ Usil__ Newfrom Template Open from file
-9 Grd Export as Template
frnlll - 17 M)
HG; Reviewed: Solution & Interoperability Test Lab Application Notes
SPOC 8/9/2017 ©2017 Avaya Inc. All Rights Reserved.

19 of 41

NexVortexIPO10



Navigate to C:\Program Files\Avaya\lP Office\Manager\Templates (or C:\Program Files
(x86)\Avaya\lP Office\Manager\Templates), on the bottom right hand side choose Template
Files (*.xml) format and select the template, in this case NexVVortexIPO10.xml was selected.

I Open

@Uv| |> Computer » Avaya e50E (C:) » Program Files (x36) » Avaya » IP Office » Manager » Templates

Organize - Mew folder
= Recent Places = MName Date medified Type
] ] = NexWortexdPO10.xml 6/14/2017 12209 PM XML Document
= Libraries

After the import is complete, a final import status pop-up window will open stating success or
failure. Click OK

Temnplate Provisioning @

'0' Mew SIP Trunk created successfully using selected ternplate.

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

IP Offices

#-R BOOTP (3)

4;_...-;:1 Operator (3)

= -3 0DE0OT06530F
'i'"'!'"’" System (1)

—-T4 Line (3)

It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP
Line is created via the template. The resulting SIP Line data can be verified against the manual
configuration shown in Sections 5.3.3 t0 5.3.9.
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5.3.3. SIP Line = SIP Line Tab

On the SIP Line tab in the Details pane, configure or verify the parameters as shown below:

e Leave the ITSP Domain Name and Local Domain Name blank.

e Verify that In Service box is checked, the default value. This makes the trunk available
to incoming and outgoing calls.

e Verify that Check OOS hox is checked, the default value. IP Office will use the SIP
OPTIONS method to periodically check the SIP Line.

e Verify that Refresh Method is set to Auto.

e Verify that Timer (sec) is set to On Demand.

e For the compliance test REFER support was disabled. Thus, Incoming Supervised
REFER and Outgoing Supervised Refer should be set to Never. Refer to Section 2.1
for the reason this field was disabled.

e Click OK to commit (not shown).

IP Offices IE SIP Line - Line 17
+’S BOOTP (3) * || SIP Line |Transpor‘t|SIP URIlVoIP |T38 FaxlSIP CredentialslSIP AdvancedlEngineering|
447 Operator (3
= Line Number 17 = In Service
ITSP Domain Name Check 005
Local Domain Name
URI Type [SIP -I Session Tirmers
Location [Cloud -] Refresh Method Auto
Timer (sec) On Demand
Prefix
Mational Prefix 0
= International Prefix 0o
Country Code Redirect and Transfer
Name Priority System Default . Incoming Supervised REFER INe\.rer
Description Service Provider Outgoing Supervised REFER INe\.rer
Send 302 Moved Temporarily 0
Outgoing Blind REFER 0
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5.3.4. SIP Line - Transport Tab

Select the Transport tab. Set or verify the parameters as shown below:
e Setthe ITSP Proxy Address to the FQDN to be used to retrieve NexVortex’s Proxy IP
addresses via public DNS SRV record queries. The FQDN should be provided by
NexVortex. FQDN: test123.com was used for the testing, which resulted in the public

DNS responding with two SRV records and proxy IP addresses, one used as primary and
one as secondary.

e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to None (refer to the note below).
e Setthe Send Port and Listening Port to 5060.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

IP Offices = SIP Line - Line 17*
#-& BOOTP (5) “ | |SIP Line| Transport [SIp URI|VolP | T38 Fax|SIP Credentials | SIP Advanced| Engineering
¢ Operator (3
=] [PS00V2 Main ITSP Proxy Address  testl23.com
—-=p System (1)
b3y IPS00V2 Main - )
[ Line 23) Metwork Configuration
! Layer 4 Protocol |UDP v| Send Port 5060
- 2
Use Network Topology Info |None v| Listen Port 5060
-y, 18
™ 19 Explicit DNS Server(s) 0 0 0 0 0 0 0 0
gy 1 Calls Route via Registrar [+
g 22
- 201 .
T Separate Registrar

Note — For the compliance testing, the Use Network Topology Info field was set to None,
since no NAT was used in the test configuration. In addition, it was not necessary to configure
the System = LAN2 = Network Topology tab for the purposes of SIP trunking. 1f a NAT is
used between Avaya IP Office and the other end of the trunk, then the Use Network Topology
Info field should be set to the LAN interface (LAN1 or LAN2) used by the trunk and the

System = LANL1 (or 2) = Network Topology tab needs to be configured with the details of
the NAT device.

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 22 of 41
SPOC 8/9/2017 ©2017 Avaya Inc. All Rights Reserved. NexVortexIPO10




5.3.5. SIP Line — SIP Credentials Tab

Select the SIP Credentials tab, and then click the Add button to add the SIP Trunk registration
credentials. Set the parameters as show below:

e For User name, add the user name credential provided by NexVortex for SIP Trunk
registration.

e For Authentication Name, add the authentication name credential provided by
NexVortex for SIP Trunk registration. For the compliance test the same value used under
User Name was used.

e Leave the Contact blank.

e For Password and Confirm Password, add the password credential provided by
NexVortex for SIP Trunk registration.

e Set Expiry (mins) to a value acceptable to the enterprise. This setting defines how often
registration with NexVortex is required following any previous registration. For the
compliance test 2 minutes was used.

e Verify that Registration required is checked.

e Click the OK to commit (not shown).

IP Offices F SIP Line - Line 17*
=& BOOTP (5) - |SIP‘ LinelTransportlSIP URIlVoIP |T38 Fax| SIP Credentials|SIp AdvancedlEngineering|

+# Operator (3

EI---’-_“,. Index User Name Authentication Mame Contact Expiration (mins) Register

2 System (1) 1 userl 23 userl 23 2 True

i IPS00YZ Main

o t{ine 23]

..... 1

..... 2

17

..... " . 18

..... J[ZT{; 206

..... 1 207 Edit SIP Credentials

""" Ti; 208 Llser name userl?23

..... T]: zﬂg

----- T3 210 Authentication Name userl23

..... -T]: 211

..... 3 212 Contact |

..... -T]: 213

..... 3 214 Password TTTIIT YT
?:E ig Confirm Password LLLLLTE L

(-2 Control Unit (4) Expiration (mins) 2 =

[+4& Extension (48)

g% g::ruf?j:-'] | & Registration required
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5.3.6. SIP Line - SIP URI Tab

A SIP URI entry needs to be created to match each incoming number that IP Office will accept
on this line. Select the SIP URI tab, and then click the Add... button and the New Channel area
will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at the
top, and click the Edit... button. In the example screen below, a previously configured entry was
edited. For the compliance test, a single SIP URI entry was created that matched any DID
number assigned to an IP Office user. The entry was created with the parameters shown below:

Set Local URI, Contact, Display Name to Use Internal Data.

Set Identity under Identity to Auto.

Set Header under Identity to P Asserted ID.

Set Send Caller ID under Forwarding and Twinning to P Asserted ID.
Set Diversion Header to None.

Set Registration to 1: xxxxxxx under Registration, XxXxxxxxxx representing the
credentials used for SIP Trunk registration under the SIP Credentials tab (Section 5.3.5).

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 17 was defined that only contains this line (line 17).

Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

Click OK to commit (not shown).

Click OK to commit again (not shown).
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IP Offices = SIP Line - Line 17
* BOOTP (5] |SIP LinelTransportI SIP URIlVoIP |T38 FaxlSIP Credentials| SIP Advanced | Engineering
; Operatar (3
Q---*-j: IP500V2 Main URI Groups Lecal URI  Contact Display Marme Identity Header Originator Murr
# System (1) ) 17 17 <«Internal> <Internal> <Internal> Auto
5= IP500V2 Main
-t Line (25)
""" " 17
..... " . 18
Edit URI
Local URI Use Internal Data
Contact Use Internal Data
Display Mame Use Internal Data
Identity
Identity Auto -
Header P Asserted ID ~
Farwarding And Twinning
Originator
MNumber
Send Caller ID P Asserted 1D -
-2 Control Unit (4)
[+-48 Extension (48)
@ User (50) o
-5 Group (1) Diversion Header Mone
[H- 8% Short Code (69) N i
_____ @ Service (0) Registration 1: userl23
o RAS (1:_] Incoming Group 17 -
[]—--@ Incoming Call Route (3)
""" £ WaN Port (0) Outgoing Group 17 -
----- @ Directory (0)
..... 7 Time Profile (0) Max Sessions 10 =
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5.3.7. SIP Line - VoIP Tab

Select the VoI P tab, to set the VVoice over Internet Protocol parameters of the SIP Line. Set or
verify the parameters as shown below:

e The Codec Selection was configured using the Custom option, allowing an explicit
order of codecs to be specified for the SIP Line. The buttons allow setting the specific
order of preference for the codecs to be used on the SIP Line, as shown. NexVortex
supports codec G.711 ULAW and G.729(a), for audio, with G.7211ULAW being the
preferred codec.

e Select T.38 for Fax Transport Support (refer to Section 2.2).

e Set the DTMF Support field to RFC2833. This directs IP Office to send DTMF tones

using RTP events messages as defined in RFC2833.
Check the Re-invite Supported box.

Check the PRACK/100rel Supported box.

Default values may be used for all other parameters.
Click the OK to commit (not shown).

IP Offices | b SIP Line -Line 17

+’$ BOOTP (3] |SIP LinelTransportlSIP URIl VelP IT38 FaxlSIP CredentialslSIP AdvancedlEngineering|

WolIP Silence Suppression

[T} Local Hold Music

Codec Selection ICustom | " Re-invite Supported

U d Selected
nuse Slecte [7] Codec Lockdown
G711 ALAW 64K i G711 ULAW 64K

G722 64K G.729(a) 8K C5-ACELP [C] Allow Direct Media Path
G.7231 6K3 MP-MLQ

Force direct media with phones

|[@ PRACK/100rel Supported

G.711 Fax ECAN

Fax Transport Support IT38 v‘

DTMF Support [Recas33 -

Media Security Disabled -

Note: The codec selections defined under this section (SIP Line — VoIP tab) are the codecs
selected for the SIP Line (Trunk). The codec selections defined under Section 5.2.3 (System —
VoIP tab) are the codecs selected for the IP phones/extension (H.323 and SIP).
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5.3.8. SIP Line — T38 Fax Tab
Select the T38 Fax tab, to set the Fax over Internet Protocol parameters of the SIP Line. Set or
verify the parameters as shown below:
e Uncheck the Use Default VValues at the bottom of the screen.
e Setthe T.38 Fax Version to 0, NexVortex supports T.38 fax version 0.
e Default values may be used for all other parameters.

IP Offices ‘ iz 3IP Line - Line 17*
: ~ & BOOTP (5) |SIP LinelTransportlSIP URIl‘u’oIP |T38 FEXlSIP CredentialslSIP AdvancedlEngineering
-7 _Operator (3
- IPE00Y2 Main T38 Fax Version ’U v]
&= System (1) Scan Line Fix-up
{ iy IPS00V2 Main Transport UDPTL
S L #| TFOP Enhancement
B Line (25) Redundancy
""" 1 [C] Disable T30 ECM
----- a2 Low Speed =
17 [] Disable EFlags For First DIS
""" w18 High Speed = [] Disable T30 MR Compression
""" " 19
""" g, 20 TCF Methed [TransTCF v] [ MSF Override
..... wy, 21
..... ~ 22 Max Bit Rate (bps) (14400 - L
----- ~, 23 —
..... 7200 EFlag Start Timer (ms) 2600 = 0
----- 7 202 . 2300 s
_____ £ 203 EFlag Step Timer (ms) =
""" Tj 204 Tx Metwork Timeout (sec) 150 =
----- 17 205
----- 17 206
..... 17 207 ||:| Use Default‘u‘aluesl
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5.3.9. SIP Line — SIP Advanced Tab

Select the SIP Advanced tab. Set or verify the parameters as shown below:
e Verify Call Routing Method is set to Request URI.
e Check the box for Use PAI for Privacy.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).

—

IP Offices = SIP Line - Line 17 [
& BooTP (5) SIP Line| Transport|SIP URI| VolP | 738 Fax| SIP Credentials|SIP Advanced [Engineering
“* Qperator (3
Addressing Media
= Svet,
ys;’;oél\ﬂz Main Association Method [By Source IP address =] Allow Empty INVITE 0
e 25)] | Send Empty re-INVITE ]
Call Routing Method Request URL -
e 1 2 hewhng ° l =iE= | ] Allow To Tag Change ]
el
Supress OSSR Lockups ] P oy st Sopor
-y, 18 Send SilenceSupp=0ff [
g, 19 Identity
-, 20 " "
g 71 Use "phone-context M Media Connection
o, 22 Add user=phone ]} Preservation
- 23 Use + for International ] Indicate HOLD &
};: ;gé Use PAI for Privacy |
17, 203 Use Domain for PAL ] Call Control
F1 204 Swap Fi d PAI/Diversi =
T" 205 wap From and PAI/Diversion a Call Initiation Timeout (s) 4 =
T_" Caller ID from From header ]
}_l' ;gg Send From In Clear ] Call Queuing Timeout (mins) 5 =
}:‘- 208 Cache Auth Credentials Service Busy Response 486 - Busy Here
F1 209
T4 210 User-Agent and Server Headers on Mo User Responding Send | 408-Request Timeout
nm - o —
Y 22 Send Location Info biever Action an CAC Location Limit | Allow Vaicernail
% 213 Su
- ppress 0.850 Reason
$2 i; Header o
15 76 Emulate NOTIFY for REFER. [
=+ Control Unit (4) Mo REFER. if using Diversion =
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 28 of 41
SPOC 8/9/2017 ©2017 Avaya Inc. All Rights Reserved. NexVortexIPO10



5.4. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
Line defined in Section 5.3. To configure these settings, first navigate to User - Name in the
Navigation pane where Name is the name of the user to be modified. In the example below, the
name of the user is H323 ext1502. Select the SIP tab in the Details pane. The values entered for
the SIP Name allow matching of the SIP URI for incoming calls without having to enter this
number as an explicit SIP URI for the SIP line (Section 5.3.6). The SIP Name and Contact are
set to one of the DID numbers assigned to the enterprise by NexVortex (the digit 1 is required in
front of the DID number). The SIP Display Name (Alias) parameter can optionally be
configured with a descriptive name. Click the OK to commit (not shown).

IP Offices | E: H323 ext 1502: 1502°
_: 0 DialIn | Voice Recording | Butten Programming | Menu Proegramming | Mebility | Group Membership Announcements

----- RemoteManager
""" ik NoUser SIP Name 12015781234
----- 1101 Extn1101dep
""" 1102 Extn1102dcp SIP Display Mame (Alias) Extn 1502
----- 1103 Extn1103dcp
----- 1104 Extn1104 Contact 12015781234
----- 1105 Extn1105
----- 1106 Extn1106
----- 1107 Betn1107 Anonymous
----- 1603 Extn1603
""" 1502 H323 ext 1502
----- 1542 H323 ext 1542
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5.5. Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing
can be specified so that a call can re-route automatically if the primary route or outgoing line
group is not available. While detailed coverage of ARS is beyond the scope of these Application
Notes, and alternate routing was not used in the reference configuration, this section includes
some basic screen illustrations of the ARS settings used during the compliance testing.

5.5.1. Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code, the Navigation pane and
select New. The screen below shows the short code 9N created (note that the semi-colon is not
used here). In this case, when the IP Office user dials 9 plus any number N, instead of being
directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which is
configurable via ARS.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N
was used (note that the semi-colon is not used here).
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Setthe Line Group ID to 50: Main to be directed to Line Group 50: Main, this is
configurable via ARS.
e For Locale United States (US English) was used.
e Click the OK to commit (not shown).

IP Offices = 9N: Dial
----- L L = || Short Code
----- PX 46
..... o +47 Code aM
----- P *43
..... X 49 Feature Dial
----- 2X *50
..... @ *51 Telephone Mumber M
..... Px 52 . - Mai
_____ O 53NE Line Group ID 30: Main
""" @55 Locale United States (US English)
----- BX *57*NE
..... BX B0 Force Account Code
""" Px *ﬁl*N’_{ Force Authorization Code
----- BX *T0* N2
..... “ EN
-
----- 83 _FNEOD
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The following screen shows the sample ARS configuration for the Line Group ID to 50: Main.
Note the sequence of X’s used in the Code column of the entries to specify the exact number of
digits to be expected, following the access code and the first set of digits on the string. This type
of setting results in a much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation pane and
click Add.
In the Code field, enter the dial string which will trigger this short code. In this case, 1
followed by 10 X’s to represent the exact number of digits after the 1.

Set Feature to Dial. This is the action that the short code will perform.

Set Telephone Number to 1N. The value N represents the additional number of digits

dialed by the user after dialing 1 (The 9 will be stripped off).

Set the Line Group ID to the Line Group number being used for the SIP Line, in this
case Line Group ID 17 was used.

Set the Locale to United States (US English).

Click OK to commit.

Line Group 1D
Locale

17

| Edit Short Code
Code THQOOCO000,
Featurs Dial =
Telephone Number 1N lﬂl

United States (LS English)

-

Force Accourt Code
Force Authorization Code

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out
from IP Office.
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The highlighted items below shows a subset of dial patterns used during the compliance test, the
user dialed 9, followed by 1 and 10 digits (represented by 10 X’s). In each case the 9 is stripped
off, the remaining digits, including the 1 are included in the SIP INVITE message IP Office

sends to NexVortex.

IP Offices Main &
=& BOOTP (5) ARS
(¢ Operator (3
5"‘ ARS RouteID 50 Secondary Dial tone
%37 System (1)
T;;]_T;elp(:g?vz Main Route Name Main [SY“E"‘TD"‘E e
<= Control Unit (4)
& Extension (48) Dial Delay Time System Default (4) L Check User Call Barring
§ user(s0)
i Group (1) i
- BX Short Code (69) Description
9 Service ()
olfs RAS (1)
@ Incoming Call Route (3 In Service Qut of Service Route [< MNone> v]
~EF) WAN Port (0) 1
+-om Directory (0)
-7 Time Profile (0) Time Profile <None> ey (Jut of Hours Route [<None> v]
@ Firewall Profile (1)
B 1P Route (7) l
-l Account Code (0)
R License (90) Code Telephone Number Feature Line Group ID = Add
i Tunnel {0)
g3 User Rights 8) 11XX 11N Dial 17
I 16X 16N Dial 17 El
LXK i Dial 17 m :
51: Outbound Fax X0 2N Dial 17
@ Location (0]
411 411 Dial 17
Authorization Cod
8 Avthoriztion Code (1) 611 611 Dial 17
BN 6N Dial 17 2
4 1 | »
3 l
30 | ey Alternate Route: <None> -
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5.6. Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system.

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any predefined extension in IP
Office. The routing decision for the call is based on the parameters previously configured for
Call Routing Method and SIP URI (Section 5.3.6) and the users SIP Name and Contact,
already populated with the assigned NexVortex DID numbers (Section 5.4).

5.6.1. Incoming Call Route — Standard Tab

On the Standard tab of the Details pane, enter the parameters as shown below:
e Set Bearer Capacity to Any Voice.
e Set the Line Group ID to the incoming line group of the SIP Line defined in Section 5.3, in
this case 17 was used.
e Default values can be used for all other fields.

Ll

IP Offices = 17
1R BOOTP (5) Standard | Voice Recording | Destinations |
-4 Operator (3
=)-={ IP500V2 Main
+)-%53 System (1) Bearer Capabili Any Voice T
-7 Line (26) penity I -
1] Control Unit (4) Line Group ID 17 -
+¢ Extension (48)
+i User (50) Incoming Mumber
- Group (1)
-9 Short Code (69) Incoming Sub Address
B Service (D) :
+“% RAS (1) Incoming CLI
% Inceming Call Route (3] Locale I v]
- Priority Il - Low v]
I U
----- EB WAN Port (0) Tag
----- @ Directory (0]
..... 7 Time Profile (0) Held Music Source IS],rstem Source VI
+-414} Firewall Profile
+g 1P Route (7) S Ring Tone Override Mone -
----- B Account Code (0)
----- 8 License (90)
----- % Tunnel (0)
#-§5 User Rights (8)
- ARS (2)
-8 Location (0]
-4 Authorization Cede (0)
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5.6.2. Incoming Call Route — Destinations Tab

Under the Destinations tab, enter “.” for the Default VValue. This setting will allow the call to be
routed to any destination with a value on its SIP Name field, entered on the SIP tab of the User,
which matches the number present on the user part of the “To” header on the incoming INVITE

message received from NexVortex. Click OK to commit (not shown).

IP Offices

| F

17

=& BOOTP (3)

T
i+ Control Unit (4)
a4 Extension (48)
w-§  User (50)

-3 Group (1)
&8 Short Code (69
@ Service (0)

-l RAS
—e Incoming Call Route (3)
P
-0

L™
-4} WAN Port (0

@ Directory (0)

-1 Tirme Profile (0)

+@ Firewall Profile (1)
-l 1P Route (7)

-l Account Code (D)
B License (90)

-l Tunnel (0)

3 ﬁ 3 User Rights (8)

- ARS (2)

E Location (0)

ﬂ Authorization Code (0)

| Standard |Voir_e Recording | Destinations

4

TirmeProfile Destination

Fallback Extension

Default Value

|v||
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5.7. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.
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6. NexVortex SIP Trunking Service Configuration

To use NexVortex’s SIP Trunking Service, a customer must request the service from NexVortex
using the established sales processes. The process can be started by contacting NexVortex via the
corporate web site at: https://www.nexvortex.com/ and requesting information.

During the signup process, NexVortex and the customer will discuss details about the preferred
method to be used to connect the customer’s enterprise network to NexVortex’s network.

NexVortex is responsible for the configuration of NexVortex SIP Trunking Service. The
customer will need to provide the public IP address used to reach the IP Office at the enterprise.
In the case of the compliance test, this is the public IP address of the IP Office WAN port
(LAN2).

NexVortex will provide the customer the necessary information to configure IP Office following
the steps discussed in the previous sections, including:

e FQDN to be use for public DNS SRV record queries.

e SIP Trunk registration credentials (User Name, Password, etc.).

e DID numbers.
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7. Verification Steps

This section provides verification steps that may be performed to verify that the solution is
configured properly.

The following steps may be used to verify the configuration:
e Verify that endpoints at the enterprise site can place calls to the PSTN.
e Verify that endpoints at the enterprise site can receive calls from the PSTN.
e Verify that users at the PSTN can end active calls to endpoints at the enterprise by
hanging up.
o Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

7.1. IP Office System Status
The following steps can also be used to verify the configuration.

Use the IP Office System Status application to verify the state of SIP connections. Launch the

application from Start - Programs - IP Office - System Status on the PC where IP Office
Manager is installed, log in with the proper credentials.

AVAyA IP Office System Status

Help Exit About

Online | offline

Logon

Control Unit IP Address: EloEERriR -

Local IP Address: [ T IR

[ Auto reconnect

[l secure connection Logon
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

I :i HAovaya IP Office System Status - IPS00V2 Main (10.64.70.60) - IP300 V2 10.0.0.3.0 build 5 _ E@g‘
AVAyA IP Office System Status

Ip Snapshot LogOff Exit About

Status  Utlization Summary Alarms

SIP Trunk Summary

Line Service State: In Service
Peer Domain Mame: sip:ffi
Resolved Address:

Line Number: 17
MNumber of Administered Channels: 10
MNumber of Channels in Use: i}
Administered Compression: G711Mu, G729 A
Enable Faststart: Off
Silence Suppression: On

Media Stream: RTP
Lavyer 4 Protocol: DR

SIP Trunk Channel Licenses:

SIP Trunk Channel Licenses in Use:

SIP Device Features:

urr... Time R ... Co Caller Other Dire... Rou...
in 5... Med v Partyo..

Trace [ Trace All ][ Pause ][ Fing ] Call Details Graceful Shutdown ][

Print... || Savess.. |

1:46:58 PM
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7.2. Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start - Programs - IP Office >
Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the
taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office Sys™Monitor - [STOPPED]
File Edit Wiew Fikers Status Help

=& »8T| x|V @ ==

' RN

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

All Settings =3
T1 | woomp | wPN | weN | soN | ssl | Jade |
aTM | Cal | DTE | ECont | FrameRelaw | GOD | H323 | Interface |
15SDM | Few/Lamp | Directon | Media | PFP | R2 | Routing | Services SIF |S_l,lstem|
Ewvents
¥ Sip [Vobose - I STUM [~ SIP Dect
Packetz
[~ SIP Reg/Opt R= [~ SIP Misc B=
[~ SIP Reg/Opt Tx [ SIP Misc Tx
[ SIPCallRx [~ Crn Motifp R«
[~ SIPCallTx [~ Crn Motify T=
I+ Sip Rx I hex IP Filter [nan.nnn.nnn. nnn)
¥ Sip Tx ™ hex |
Default AII| Clear All | Tab C|eam||| Tab sBmu| 86 ]| cancel
Save | Load File | Load Partial File| Select File |
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8. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office
Release 10.0 to NexVortex SIP Trunking Services. NexVortex SIP Trunking Services is a SIP-
based Voice over IP solution for customers ranging from small businesses to large enterprises. It
provides a flexible, cost-saving alternative to traditional hardwired telephony trunks.

Interoperability testing was completed successfully with the observations/limitations outlined in
the scope of testing in Section 2.1 as well as under test results in Section 2.2.

9. Additional References

This section references the documentation relevant to these Application Notes. Product
documentation for Avaya IP Office, including the following, is available at:
http://support.avaya.com/

[1] Avaya IP Office Platform Solution Description, Release 10.0, August 2016.
[2] Avaya IP Office Platform Feature Description, Release 10.0, August 2016.
[3] Deploying Avaya IP Office Platform IP500 V2, Document Number 15-601042, Issue 31q,
February 06, 2017.
[4] Administering Avaya IP Office Platform with Manager, Release 10.0, September 2016.
[5] IP Office Platform 10.0 Using Avaya IP Office Platform System Status, Document 15-
601758, Issue 11f, February 06,, 2017.
[6] IP Office Platform 10.0 Using IP Office System Monitor, Document 15-601019, Issue 08b,
November 25, 2016.
[7] Using Avaya Communicator for Windows on IP Office, Release 10, August 2016.
[8] Administering Avaya Communicator on IP Office, Release 10.0, Issue 01.01, August 2016
[9] IP Office Platform 10.0 Installing and Maintaining the Avaya IP Office Platform Application
Server, Document 15-601011, Issue 11j, January 31, 2017.
[10] Avaya Communicator for Web-1P Office Platform, User Guide, Release 1.0, Issue 1.0.11,
October 2016.
[11] Avaya Communicator for Web-I1P Office Platform, Administration Guide, Release 1.0, Issue
1.0.16, January 2017.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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